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1

20-sim 4.4

1.1

Versions

20-sim is available in two versions: Viewer and Professional.
Viewer/Demonstration version: This is a freeware version that allows you to load and
run models and evaluate the package. Saving of models is not possible in this version.
Professional: This is the full version of 20-sim with all toolboxes.
The table below shows in detail the options that are available in the three versions:
Viewer

Professional

Library Models

v*

v

3D Mechanics Toolbox

v*

v

Animation Toolbox

v*

v

Control Toolbox

v*

v

Frequency Domain Toolbox

v*

v

Mechatronics Toolbox

v*

v

Real Time Toolbox

v*

v

Time Domain Toolbox

v*

v

x

v

Scripting Toolbox

v = included
v* = included but no saving possible
x = not included
20-sim is installed, using an Installation Manager that will lock 20-sim to your computer.
There are three types of licenses available:
Viewer/Demonstration: The free demonstration version comes with a license that is
not locked to your computer. No actions have to be taken after installation of 20-sim to
use this license. The limitation of this license is that you cannot save any modifications.
Single License: A single license locks 20-sim to a specific computer. After installation
you have to register to get a valid license.
Floating License: A floating license allows multiple users to work with 20-sim at the
same time. After installation you have to register to get a valid license.

1.2

Requirements

20-sim only works on computers that will meet the following requirements:
Operating System: Windows XP, Vista, 7 or 8.
Processor requirements: 20-sim requires a CPU with SSE2 support. Supported: Intel
Pentium 4 and above, AMD Athlon x64 and above.
Available Disk Space: 220 MB.
Installation manual
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1.3

Installing 20-sim (Single)

20-sim can be downloaded from the website www.20sim.com. This is an installation file that
will install 20-sim on your computer. The first 4 steps are equal for all users. Depending on
the type of license (single, floating) you have to continue differently.
1.

Install 20-sim and start the program.

If a valid license of 20-sim was activated before, the program will start automatically and you
can skip the rest of this section. If you have not installed 20-sim before, the License
Information dialog will open. You can also manually open the License Information dialog:
2.

From the Help menu select License Activation.

Use the Registration/Update window to request for a license.
3.

If you have a valid license key or license file, press the Activation button to enter your
license key or browse for the license file.

If you do not yet have a valid license, press the Trial License button request an trial license
or press the Buy button to purchase a license. If you want to continue in Viewer mode (no
save functionality), just close the dialog without activating 20-sim.
4.

Select which kind of license you have and who should use the license.
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License installation dialog.
5.

On the next dialog, select I received a license key by e-mail and enter the key in the
next dialog. When you received a license file, you have to enter the location of the
license file.

You will be asked for confirmation (click Activate Now) and activation will be carried out.
After a successful activation process the License Information dialog will show the new license
(Standard License or Professional License).

1.4

Installing 20-sim (Floating)

A floating license (also known as concurrent license or server license) is a license that is
shared by more users. A floating license has to be installed by the administrator first and
then for the users. You can only install a floating license if you have received a license key.

Prerequisites
A valid 20-sim floating license key
A Windows, Linux or MacOSX server that is accessible by all users that will use the
floating license.
A dedicated Windows share on this server.
For example:

\\fileserver\20simlicense

This share on the server should be accessible by all 20-sim users and the share should
have read and write permissions for all 20-sim users.
Note: Windows DFS (distributed file system) shares are not supported.

Administrator
The 20-sim installation can be downloaded from the website www.20sim.com if you do not
have it already.
1.

Install 20-sim and start the program.
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2.

From the Help menu select Registration/Update License.

The License Information dialog will open:

Use the Registration/Update window to request for a license.
3.

Press the Activation button.

4.

Select Floating and who will use the license.

License installation dialog.
You have to enter the license key and a location on the server first. This location on the
server should be accessible to all users and should have read/write permission.
5.

On the next dialog, select First Installation and click Next.
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Choose First Installation
6.

Enter the 20-sim floating license key and the location on the server where the
floating license should be stored.

Choose First Installation
A 20-sim license file named 20sim.lic will be installed on the provided license location.
7.

Write down the location of this file because every new user of this 20-sim floating
license will need to enter it.

You will be asked for confirmation (click Activate Now) and activation will be carried out.

Web Activation dialog.

Users
Every 20-sim user has to install 20-sim on his local computer and enter the location of the
20-sim floating license.
1.

Install 20-sim and start the program.

2.

From the Help menu select Registration/Update License.

3.

Press the Activation button.
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4.

Select Floating and who should use the license.

5.

On the next dialog, select Administrator already installed server license and choose
Next.

Choose the second option
6.

Enter the license file location (ask your system administrator for the location of the
20-sim floating license) and click finish.

Enter the license location
If everything went right, 20-sim is now activated using the floating license stored on the server.

In case of problems, contact Controllab Products
E-mail:

1.5

info@20sim.com

ClassroomKit

For educational purposes, 20-sim is available as a Classroom Kit. A Classroom Kit lets
students and teachers use the software at the educational institute and at home. The use is
limited to a maximum of 200 individual users and 200 users on the network of the
educational institute.
A Classroom Kit comes with two types of license keys:
A student license key which may be distributed among students and teachers (max. 200
users).
Installation manual
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A floating license key which can be installed at the educational institute (max. 200 users).

Student License Key
A student license key has a time limitation of one year. Controllab Products B.V. will take care
that every year a new student license key is sent to the owner of a Classroom Kit.
1.

The student license key has to be stored on a location that is only available for students
and teachers (place it on your intranet) to prevent illegal copying.

2.

Install 20-sim with the student license key. For installation guidelines see the section on
installing a single license.

Floating License Key
The floating license key will have no time limitation. It allows you to use 20-sim on multiple
machines on the network.
1.

To install a floating license key follow the instructions of the previous section.

1.6

Uninstalling

You can uninstall 20-sim by clicking the Uninstall command from the 20-sim start menu.
Uninstalling of 20-sim will not deactivate your license. If you want to move 20-sim to
another computer, you have to deactivate your license first before uninstalling.

1.7

Deactivation

If you want to move 20-sim to another computer, you have to deactivate your license before
uninstalling the program. On the new computer you can then install the program and activate
the license. To deactivate your license:
1.

From the Windows Start menu open 20-sim.

2.

From the Help menu choose License Activation.

3.

Press the Activation button.

4.

Choose Deactivate the License and click Finish

You will be asked for confirmation and deactivation will start. After a successful deactivation,
you version of 20-sim has turned into the demonstration version. You can now uninstall the
software and reinstall it.
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20-sim 4C 2.1

2.1

Requirements

20-sim 4C only works on computers that will meet the following requirements:
Operating System: Windows XP, Vista, 7 or 8.
Available Disk Space: 350 MB.
Ethernet: an ethernet connection is required for external targets.
Further requirements for using 20-sim 4C:
20-sim 4.1.2.4 Professional (or higher) installed on the same computer.
A valid 20-sim 4C license. Contact your local distributor to obtain a valid license. Note that
20-sim 4.1 (or higher) Professional and the 20-sim 4C 2.1 have separate licenses!

2.2

Installing 20-sim 4C

20-sim4C can be downloaded from the website www.20sim4C.com. This is an installation file
that will install 20-sim on your computer. In this topic we describe how to obtain a valid
license for 20-sim.
1.

Install 20-sim 4C on the same computer as 20-sim 4.1 Professional or higher.

2.

From the Windows Start menu open 20-sim 4C.

If a valid license of 20-sim 4C was activated before, the program will start automatically. If
you have not installed 20-sim 4C before, the License Activation dialog will open:

20-sim 4C 2.1 License Activation Dialog.
If you have a valid license key or license file, press the Activation button to enter your
license key or browse for the license file.
If you do not yet have a valid license, use the e-mail button
to request an evaluation
license or to purchase a license.
3.
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4.

Select which kind of license you have and who should use the license.

License installation dialog.
5.

On the next dialog, select I received a license key by e-mail when you have a license
key. When you got a license file, select the other option.

License key or license file?
6.

Enter your 20-sim 4C license key (or browse for the license file):

Enter your license key.
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7.

In case of a license key, 20-sim 4C will now validate your license on-line. Please make
sure that you have a working Internet connection. Click Activate now to continue.

On-line license activation.
As a result of a successful license installation, 20-sim 4C shows your license information in a
dialog:

License activation was successful.
After closing the license information dialog, 20-sim 4C is ready for use and should look like
the figure below:
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20-sim 4C.
If you cannot open 20-sim 4C or have problems with the installation or the license activation,
please check the troubleshooting section. If this does not help, please contact Controllab
Products B.V.

2.3

Uninstalling 20-sim 4C

You can uninstall 20-sim 4C by clicking the Uninstall command from the 20-sim 4C start
menu. Uninstallation of 20-sim 4C will not deactivate your license. If you want to move 20sim 4C to another computer, you have to deactivate your license first before uninstalling.

2.4

Deactivation

If you want to move 20-sim 4C to another computer, you have to deactivate your license,
before uninstalling the program. On the new computer you can then install the program and
activate the license.
To deactivate your license:
1.

From the Windows Start menu open 20-sim 4C.

2.

From the Help menu choose License Activation.

The License Activation dialog will open.
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The License Activation dialog.
3.

Click on the Activation button and then select Deactivate Current License.

Click Deactivate Current License if you want to use the program on another computer.
4.

Click Finish to deactivate your license. You will be asked to confirm the deactivation and
have to click Deactivate.
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2.5

Upgrading

If you want to upgrade to a newer version of 20-sim 4C, go to the 20-sim 4C website and
download the new version. After downloading you can install it.
If the new version is a minor update (e.g. version 2.0.x.x), it will automatically replace
the old version. After installation you can run the new version immediately. No new
license is required.
If the new version is a major upgrade (e.g. version 2.1.x.x or higher), it will be installed
next to the old version. Both versions can be used at the same time. The new version will
require a new license.

2.6

Unattended Installation

An unattended installation is an installation that is performed without user interaction during
its progress or with no user present at all.
To perform an unattended installation the default 'program files' installation directory run the
following command :
20sim.exe /S
It is possible to set an alternative installation directory by specifying the /D argument. It
must be the last parameter used in the command line and must not contain any quotes, even
if the path contains spaces. Only absolute paths are supported.
20sim.exe /S /D=D:\My Installation Files\20-sim 4.4.0

2.7

Connecting the Target

20-sim 4C uses an ethernet connection to communicate with a target. This connection can be
established using a cross cable that is connected between your PC (the host PC) and the
target directly or by connecting your PC and the target to your local network. Using a crosscable to connect the host PC directly to the target is recommended if you encounter problems
with the connection.

Plug in the cross cable or network cable.

Cross Cable
1.

Plug the cross cable in the connector of your target.

2.

The other end of the cross cable must be plugged into your host PC.
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It may take several minutes before Windows has configured the network interface. Please be
patient when 20-sim 4C cannot make a connection immediately.

Network Cable
1.

Plug the network cable in the connector of your target.

2.

The other end of the network cable must be plugged into a switch or hub of the
network.

Use a 'normal' network cable to connect the target via a switch or hub to your network. If
your network provides a DHCP server the configuration is automatic. If your network does
not provide a DHCP server make sure your network is configured in the 192.168.1.x range
and that your PC computer has a proper connection to the network.
See Networking in the Troubleshooting chapter in case you experience problems.

2.8

Running a Test model

To test if the installation was successful, we will run an example model in 20-sim and
generate C-code that will be transferred to 20-sim 4C to run on your target. The model is
called Test.emx and has no external inputs or outputs.

Exporting the 20-sim Model to 20-sim 4C
1.

From the Windows Start menu open 20-sim.

2.

In 20-sim load the model C:\Program Files\20-sim 4C 2.1\examples\20-sim
\Test.emx.

Note: For 64-bit Windows versions the location is: C:\Program Files (x86)\20-sim 4C 2.1
\examples\20-sim\Test.emx. If your version of 20-sim 4C is installed on a different location,
please use the correct path.

The model Test.emx loaded in 20-sim.
The 20-sim model Test.emx contains one submodel (named Test).
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3.

Select the submodel Test and from the Model menu select Go Down.

The submodel Test contains a block diagram model with no external inputs or outputs.
As you can see the submodel Test is a block diagram model of a first order system which
contains no external inputs or outputs.
4.
From the Model menu select Start Simulator.
Now the 20-sim Simulator opens showing an empty plot.
5.

In the Simulator from the Simulation menu select Run to run a simulation.

You should see a stepwise change in the setpoint signal and a first order response of the
system.

The simulation results for the model Test.emx.
We will generate C-code from this model and run it on a target.
6.

In the Simulator, from the Tools menu select Real Time Toolbox and C-code
Generation. The C-code Generation dialog will pop-up.
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7.

Select the 20-sim 4C target. Make sure it looks like the figure below (in 20-sim 4.1
multiple targets may be shown). If the 20-sim 4C target is not shown, please check the
troubleshooting section.

The C-code generation menu in 20-sim.
8.

Click on the Submodel button
and select the submodel Test. The C-code
Generation dialog should look like:

The C-code generation menu in 20-sim.
Note that a default location for the C-code files is given in the Output Directory field: C:\temp
\20sim-4C\%SUBMODEL_NAME%, where %SUBMODEL_NAME% will be replaced by the
submodel name. If you want to use a different location, please enter it here.
9.
Click the OK button to close the dialog.
Now the model will be exported to 20-sim 4C as C-code. All code files are stored in a
temporary folder. A dialog may appear asking you to create this folder.

The folder for temporary code files.
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10.

Click Yes to create the folder (or go to step 7 to enter another directory).

If everything works fine, 20-sim 4C will be opened, with the Test model loaded:

20-sim 4C with the Test model loaded.
If an error occurs and 20-sim 4C does not open, please check the troubleshooting section.

20-sim 4C Settings and Monitoring
We will enter the settings to get the model running on your target and choose the variables
that we would like to monitor.

Configure
1.

Click on the Configure button

.

2.
Click on the Select button, select the proper target and click OK.
The next picture shows as an example the ARM7300 - Torsion Bar v2.0 target.

Select the proper target.
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20-sim 4C will now start a search to find the IP-addresses of connected targets:

Finding the IP-address.
If a firewall is installed, a warning message may pop-up:

The Windows firewall message when the Refresh button is clicked.
3.

Click the Allow Access button (Windows 7) or the Unblock (Windows XP, Windows
Vista) button (or a similar button if another firewall message is shown) if the name of
the program is 20-sim 4C and the publisher is Controllab Products B.V.

4.

Optional: Press the Discover button on the Configure Target tab to manually repeat
step number 3.

5.

Optional: You can change the target name and IP-address manually for your target
using the Edit button.

Changing the target name and IP-address manually.
6.

Click on the Apply button.

If everything was installed and connected successfully, the Configure button
into green

should turn

.

Installation manual

18

2. 20-sim 4C 2.1

The configuration was entered successfully.
If the Configure button has turned to red

please check the Troubleshooting section.

Connect
7.

Click on the Connect button

8.

Our model does not have external inputs or outputs that we have to connect so click
the Apply button.

.

Compile
9.

Click on the Compile button

to compile the generated code into an executable.

The Compile button should turn into green
finished. If it has turned into red

when the compilation process is successfully

please check the Troubleshooting section for help.

Command
Our model has no external inputs or outputs. To make sure its runs properly we have to
monitor its internal variables during running. That is why we will first choose the variables
that we will monitor and then run the model.
10.

In the tree-view at the left side of the 20-sim 4C windows click Variables. It will
expand showing the available submodels

11.

Click on the Step submodel.

Now a list of two parameters (amplitude and start_time) and one variable (output) should be
visible.
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The list of parameters and variables of the submodel Step.
The variable output has two gray dots (Mon and Log) at the left. You can click these dots to
select the variable for monitoring or logging.
12.

With your mouse pointer go to the variable output and click on the grey dot to select it
for monitoring.

20-sim 4C should now look like:

The list of parameters and variables of the submodel Step.
Now we will choose a second variable for monitoring.
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13. Click on the Gain submodel and select the variable output for monitoring.
To see all variables that have been chosen for monitoring, you can view a Monitor Selection.
14. In the tree-view click Run and then the tab Monitor Selection.
Now 20-sim 4C should look like:

The list of monitored variables.
Now we will configure the run settings, open a monitor plot and start to run the model on the
target:
15.

Select the Configure Run tab and click on the Apply button to accept the default
settings for this run experiment. The Run button

should become green

.

Configure runtime settings.
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By default, 20-sim 4C will use the same settings as used in the 20-sim simulator. On the
Configure Run tab, you can change for example the Finish time for your model.
16.

Click on the Monitor button

to open a plot window.

17. Click on the Run button
to start running the model on the target.
Now you should see the following plot after 10 seconds of running. The plot shows a stepwise
change in the setpoint signal and a first order response of the system.

The monitored variables, shown in a plot.
If your results are similar, 20-sim 4C is properly installed and your target is properly working.
If the plot results are not similar but some other variable is shown in the plot, check if the
correct variables were chosen for monitoring (hint: check the Monitor Selection tab of step
14).
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3

Torsion Bar 2.0

3.1

Components

For the proper operation of the Torsion Bar, a PC computer is required that is connected to
the Torsion Bar either directly with a cross cable or via a network. On the PC computer, the
software packages 20-sim Professional and 20-sim 4C have to be installed. This section
describes how to make the various installations. In the next sections we will run two models
to test if the Torsion Bar is working properly.

Power
1. Check if the correct power adapter was supplied.
The Torsion Bar is delivered with a power adaptor that yields 24 V output. Depending on the
country, a 220 V or a 110 V input is used. Check if the power adaptor has the correct input
voltage.
2. Plug in the power adapter.

Plug in the power cable just below the motor. Right of the power connector is the power switch.
The output of the power adaptor can be connected just below the motor. The input of the
power adaptor has to be connected to you local 220 V or 110 V supply.
3. Switch on the power.
The power switch is located right to the power cable connector. If you switch it on some
LED's on the controller board should be turned on.

Cross Cable
For the communication between the Torsion Bar and the host PC you can use a cross cable or
a network cable. A cross cable is a direct connection with the PC. A network cable is indirect
connection because it connects the Torsion Bar with a network switch or other network
components. Using a cross-cable to connect the host PC to the Torsion Bar is the
recommended approach for first time users.
1. Plug the cross cable in the most left connector of the controller board.
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The left connector is used for the network connection.
2. The other end of the cross cable must be plugged into your PC computer.
It may take several minutes before your PC will notice that a cross cable is connected. So be
patient if 20-sim 4C cannot make a connection immediately.

Network Cable
1. Plug in the network cable in the most left connector of the controller board.
2. The other end of the network cable must be plugged in into a switch or hub of the
network.
Use a 'normal' network cable to connect the Torsion Bar Setup via a switch or hub to your
network. If your network provides a DHCP server the configuration is automatic. If your
network does not provide a DHCP server make sure your network is configured in the
192.168.1.x range and that your PC computer has a proper connection to the network.

3.2

Installation

On the PC computer two software packages have to be installed: 20-sim 4.1 Professional or
higher and 20-sim 4C 2.0 or higher:
1.

Install 20-sim 4.1 Professional or higher. For installation guidelines, see the 20-sim
Getting Started manual.

2.

Install 20-sim 4C 2.0 or higher. For installation guidelines, see the 20-sim 4C
Reference manual.

20-sim Models
In the examples, 20-sim models are used to generate C-code. These models have to be
copied onto your PC computer.
1.

Copy the example files from the CD-Rom (e.g. D:\Torsion Bar\20-sim\*.*) to a local
folder (e.g. Documents\Torsion Bar\20-sim\*.*).

Please check that you have read and write access to the local folder.
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4

TS-7300 Demonstration Kit 1.0

4.1

Components

The TS-7300 Demonstration Kit contains various components.

The components that come with the TS-7300 Demonstration Kit.

Controller Board
The controller board is the TS-7300 of Technologic Systems. The board is equipped with a
SD-card which contains a Linux-RTAI operating system. The ARM-9 CPU of the board uses
this operating system to run the models. The maximum sample frequency of a model
depends on the complexity of the model. In practice the upper limit is 2kHz for simple models
and 200 Hz for more complex models.

20-sim 4C ready SD Card
The TS-7300 board contains a slot for an SD-Card. The SD card that is delivered with the kit
contains a real time operating system (RTAI Linux) and a target daemon, to perform the
communication between 20-sim 4C and the TS-7300 board. The SD Card makes the board
plug-and-play. As soon as you power it up, the software will be started and the board is
ready to run.
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Potentiometer
The potentiometer is connected with the AD input of the board. The potentiometer will give a
voltage that can range between a minimum value of 0.15 V and a maximum value of 3.15 V.

External LED
The LED is fed by the PWM (Pulse Width Modulation) output of the board. The PWM
signal has a range of -1 to +1. Both negative and positive values will make the LED
shine. A zero value will give minimum intensity (the LED is out) and a value of -1 or
1 will give a maximum intensity (LED shines brightly).

Power Adapter
The power adaptor requires and input voltage of 100 to 240V alternating current, with a
maximum current of 0.35 A and a frequency of 50 or 60 Hz. The adaptor gives a DC output
voltage of 5 V and a maximum current of 2.5 A.

Cross Cable
A cross cable is available to connect your PC to the TS-7300 board directly, without the need
of a network switch.

4.2

Software

To run the TS-7300 board, a PC computer should be connected, either with a cross cable or
via a network. On the PC computer, the software packages 20-sim Professional and 20-sim
4C have to be installed. This section describes how to make the various installations.

SD-Card
1. Check if the SD-Card was inserted.
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Check if the SD-Card is inserted in the board.

Power
1. Check if the correct power adapter was supplied.
The Demonstration Kit is delivered with a power adaptor that yields 5 V output. Depending on
the country, a 220 V or a 110 V input is used. Check if the power adaptor has the correct
input voltage.

2. Connect the power adapter to the board as indicated in the next picture.
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Connect the power adaptor to the board at the opposite side of the network connector.

3. Switch on the power.
You switch on the power by putting the power plug of the power adapter into the local grid.
As soon as the power is on, the LED's on the controller board should start to shine. The board
will now automatically boot from the SD card.

Cross Cable
The communication between the TS-7300 board and the host PC is established with a cross
cable or a network cable. A cross cable is used for a direct connection with the PC. A network
cable is used for an indirect connection through a network switch or other network
components. Using a cross-cable to connect the host PC to the TS-7300 board is the
recommended approach for first time users.

1. Plug in the cross cable in the most left connector of the controller board.
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Plug in the cross-cable in the left connector.

To most left connect or is used for both the cross cable and network cable.
2. The other end of the cross cable must be plugged into your PC.
It may last several minutes before your PC will notice that a cross cable is connected. So be
patient if 20-sim 4C cannot make a connection immediately.

Network Cable
1. Plug in the network cable in the most left connector of the controller board.
2. The other end of the network cable must be plugged in into a switch or hub of
the network.
Use a 'normal' network cable to connect the TS-7300 board Setup via a switch or hub to your
network. If your network provides a DHCP server the configuration is automatic. If your
network does not provide a DHCP server make sure your network is configured in the
192.168.1.x range and that your PC computer has a proper connection to the network.

Potentiometer and LED
1. Check if the potentiometer and the LED connectors are mounted properly .
The potentiometer connector has to be mounted on the DIO1 pins as indicated in
the next figure. The LED connector has to mounted on the DIO2 right pins.
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The correct mounting of the connectors.

Software
On the PC computer two software packages have to be installed: 20-sim 4.0 Professional or
higher and 20-sim 4C 1.1 or higher.

1. Install 20-sim 4.0 Professional or higher. For installation guidelines, see
the 20-sim Getting Started manual.
2. Install 20-sim 4C 1.1 or higher. For installation guidelines, see the 20-sim
4C Reference manual.

20-sim Models
In the examples, 20-sim models are used to generate C-code. These models have to be
copied onto your PC computer.

1. Copy the example files from the CD-Rom (e.g. D:\TS-7300 Demonstration Kit
\20-sim\*.*) to a local folder (e.g. C:\My Documents\TS-7300 Demonstration Kit\20sim\*.*).
Please check that you have read and write access to the local folder. Therefore we
advise to copy the files to the Windows "My Documents" folder.

Installation manual

30

Index

Index

-Mmonitor

-2-

move to another computer

20-sim

20-sim Models

25

24, 26

-AActivation

-C-

14

Network Cable

13, 23, 26

network range

13

Operating System

Classroom Kit

6

other computer

14

configure

Potentiometer

14

connect

Professional
13

Cross Cable

-D-

PWM

deactivate license

25

-R-

11

7, 11

requirements

11

run

Demonstration Version

1

-E25

1, 8

14

-SSD-Card

External LED

25

Single License

-F-

1, 2

Student License Key

firewall

Floating License

1, 3

Floating License Key
Free License

target
6

1

14

-Uuninstalling

-I-

upgrading

Installing 20-sim 4C

8

14

Viewer

1

-W-

-L-

Windos 7

25

license deactivation
Linux-RTAI

8

Windows Vista

8, 13

License Activation

7, 11
13

-V-

2, 3

IP-address

6

-T-

14

Installing

25

25

PWM output

deinstalling

25
1

Pulse Width Modulatio

13, 23, 25, 26

deactivation

25

Power Adapter

14

connecting

1
11

-P-

14

compile

license

name

-O-

8

command

7

-N-

26

20-sim 4C ready SD Card

LED

14

Windows XP

8

8
8

11

25

Installation manual

31

